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1. General guidelines. Type or word process your paper. Use 12 point Times New Roman font.  Use 
high-quality, white, unlined 8 ½” by 11” paper.  

 
2. Margins.  Use one-inch margins at the top, sides, and bottom of each page.  

 
Word 2003 Word 2007/2013 
 Click on File on the menu bar.  
 Click on Page Setup. 
 Select the Margins tab.  
 Set top, bottom, left and right margins to 1”. 
 Click OK. 

 Click on the Page Layout tab.  
 Click on Margins. 
 Select Normal. 

 
3. Name and page numbers.  Place your last name, a space, and the page number at the top of each 

page of the paper.  The name and page number should appear one-half inch from the top edge of the 
page, flush with the right-hand margin.  Number the pages of the paper and the Works Cited list 
continuously, using Arabic numerals (1, 2, 3, and so on).  Do not precede the page numbers with the 
word page or any abbreviation, such as p. or pg. Your name and page number will be placed within a 
Header. 

 
Word 2003 Word 2007/2013 
 Click on View on the menu bar.  
 Click on Header and Footer. 
 Click on the Right Alignment 

button on the toolbar.  
 Type your last name and a space.  
 Click on the Insert Page # button on 

the Header and Footer toolbar.  
 Click Close on the Header and 

Footer window.  

 Click on the Insert tab. 
 Click on Header  Edit Header. 
 Type your last name and a space. 
 Click on Page Number  Top of Page  Select 

Right Aligned (3rd Option). 
 Click on the Home tab to change the font to 12 point 

Times New Roman. 
 Type your last name in front of the number. 
 Double-click below the dotted line to close the Header. 

 
4. Spacing.  Double-space the entire paper, including headings, titles, quotations, and text paragraphs.  

You will do this by setting the Line Spacing for the entire document to 2.0.  
 

Word 2003 Word 2007/2013 
 Click on Format on the menu bar.  
 Click on Paragraph.  
 Find the Line Spacing drop down box.  
 Pull it down and select Double.  
 Click OK.  

 Click on the Home tab. 
 Click on the Line and Paragraph Spacing toolbar 

button. 
 Check 2.0 for double-spacing. 

           
5. Heading.  At the left margin of the first page, drop down one inch from the top edge of the sheet and 

enter, on separate lines, your complete name, your teacher’s name, the name of your class, and the 
complete date in this form: 12 November 2015.  Double-space the heading.  
 

6. Title.  On the line following the date, center the title of your paper.  Use uppercase and lowercase 
letters, not all capitals, and italicize only those words that you would italicize in the body of your 
paper.  Double-space between the date and title and between the title and the first paragraph of the 
paper.   
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7. Indentations.  Indent the first line of each paragraph in your paper by pressing the Tab key on the 
keyboard once for a half-inch indent.   
 

8. Quotations of fewer than five lines. If the quotation is fewer than five lines, put it in quotation 
marks and place it in the text of your paper.   

 
9. Quotations of more than four lines.  When a quoted passage is more than four lines long, set it off 

from the text of your paper in a separate block.  Put a colon after the statement that introduces the 
quotation.  Begin a new line.  Indent the entire quotation one inch from the left-hand margin.  Double-
space the quotation, and do not enclose it in quotation marks.  Even though parenthetical citations are 
normally placed before the end punctuation, in this case, place the parenthetical citation at the end of 
the quotation after the end punctuation.  The sample paper at the end of this research guide contains 
an example. 

 
10. Works Cited list.  The Works Cited page should be separate from the text of the paper.  On the 

Works Cited page, after your last name and page number, drop an additional one-half inch and center 
the title Works Cited.  Do not underline the title or enclose it in quotation marks.  Additional Works 
Cited pages do not need a title. Your page numbers should be continuous from the text of the paper 
through the Works Cited entries. 

 
11. Placement and spacing of Works Cited entries.  After the title, double-space and begin the first 

Works Cited entry.  Double-space and alphabetize all the Works Cited entries. Entries should be 
alphabetized by their first words, whether the words are parts of titles or names.  If an entry begins 
with a title, skip any initial article (a, an, or the) when alphabetizing.  Begin the first line of each 
entry at the left margin.  Indent subsequent lines of the same entry a half inch.   
 

Word 2003 Word 2007/2013 
 Click on Format on the menu bar.  
 Click on Paragraph.  
 Find the Special drop down box.  
 Pull it down and select Hanging. 
 Under By, enter 0.5.  
 Click OK.  

 Click on the Home tab. 
 Click on the bottom right corner of the Paragraph box. 
 Under Indentation find the Special drop down box.  
 Pull it down and select Hanging. 
 Under By, enter 0.5.  

 
Forms for Works Cited Entries 

 
Use these guidelines when writing parenthetical citations in your research paper. 
 

1. In general, omit titles, affiliations, and degrees that precede or follow names (i.e. PhD, Sister, SJ, 
Lady, Sir or Saint). A suffix that is an essential part of the name - like Jr. or a roman numeral - 
appears after the given name, preceded by a comma (i.e. Rockefeller, John D., IV or Rust, Arthur 
George, Jr.). 
 

2. Publishers often group some of their books under imprints, or special names. If an imprint 
appears on a title page along with the publisher’s name, state the imprint and follow it by a 
hyphen and the name of the publisher (i.e. Greenhaven – Gale or Eyewitness – Kindersley).   

 
 
 
 



2015 Update                   

  3 
   

Forms for Parenthetical Documentation Within Text 
 

Use these guidelines when writing parenthetical citations in your research paper. 
 

1. Every time you use an idea that is not your own or is not common knowledge, you must include a 
parenthetical citation indicating the source of the information.  If you neglect to cite your source, 
you are plagiarizing.  Plagiarism is a serious academic offense that can result in a failing grade for 
your written project. 

 
2. If you quote directly from your source (word-for-word), you must also use quotation marks, or, if 

the quote is more than four lines, indent the entire quote.  See page 2 in this guide for more 
specific directions.  

 
3. A citation generally includes the author’s last name and the page number where the information 

was found.  It does not include punctuation (except in specific circumstances as noted in the 
following examples) and does not include any page indicators, such as p. or pg. 

 
4. In a parenthetical reference to a work alphabetized by title in the list of works cited, the full title 

(if brief) or a shortened version precedes the page. When abbreviating the title, begin with the 
word by which it is alphabetized. See Internet – No Author.  
 

5. If you wish to include two or more works in a single parenthetical reference, cite each work as 
you normally would in a reference, and use semicolons to separate the citations.  
 

6. When you add a parenthetical citation, it should appear at the end of a sentence before the end 
punctuation, except in a quote exceeding four lines or in a quote ending in a question mark. 
 

7. If what you quote is itself a quotation in your source, put the abbreviation qtd. in before your 
source (qtd. in Boswell 45). 
 

8. Multiple Sources in One Citation (Leggett 96; “Arthur Miller,” Critical) 
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Books 
 
Book – One Author 
 
Galas, Judith. Drugs and Sports. San Diego: Lucent, 1997. Print. 
 
(Galas 25). 
 
Book – Two or Three Authors 
 
Gilbert, Sandra M., and Susan Gubar. The Madwoman in the Attic: The Woman Writer and the  
 

Nineteenth-Century Literary Imagination. New Haven: Yale UP, 1979. Print. 
 
(Gilbert and Gubar 35). 
 
Demko, George J., Jerome Agel, and Eugene Boe. Adventures in Geography. New York: Anchor- 
 

Doubleday, 1992. Print. 
 
(Demko, Age, and Boe 54). 
   
Book – More than Three Authors 
 
Gatto, Joseph, et al. Exploring Visual Design. Worcester: Davis, 1987. Print. 
 
(Gatto et al. 77). 
 
Two Books – Same Author  (Note:  If you use more than one book by the same author, put the sources 
in alphabetical order by title.  Give the author’s name for the first work.  Thereafter, use three hyphens in 
place of the name.) 
 
Steinbeck, John. The Grapes of Wrath. New York: Penguin, 1999. Print. 
 
---. Their Blood is Strong. San Francisco: Lubin, 1938. Print. 
 
(Steinbeck, Grapes 38). 
 
(Steinbeck, Their Blood 79). 

 
Book – Corporate Author 
 
National Geographic Society. Cradle and Crucible: History and Faith in the Middle East. Washington:  
 

National Geographic, 2002. Print.  
 
(National Geographic 56-57). 
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Book – No Author Identified 
 
Literary Market Place: The Directory of the American Book Publishing Industry. New York: Bowker,  
 

1996. Print. 
 
(Literary Market Place 94).   Note: Use the first two or three words of the title, italicized. 
 
Book – One Editor  
 
Nabokov, Peter, ed. A Chronicle of Indian-White Relations from Prophecy to the Present. New York:  
 

Viking-Penguin, 1991. Print.  
 
(Nabokov 84). 
 
Book – Two or Three Editors 
 
Bond, Peter, and Julia Conaway Bond, eds. Dictionary of Italian Literature. Philadelphia: Greenwood,  
 

1997. Print. 
 
(Bond and Bond 59). 
 
Book – More than Three Editors 
 
Draper, James P., et al., eds. Contemporary Literary Criticism. New York: Gale Research, 1995. Print. 
 
(Draper et al. 73). 
 
Book – Multivolume Work (one volume) 
 
Medieval World. Vol 2. Danbury: Grolier, 2001. Print. 
 
(Medieval 2: 55).  
 
Note: Within the parenthetical citation, include the number of the volume you used, followed by a colon, 
one space and the page number. 
 
Book – Multivolume Work (more than one volume) 
 
Medieval World. 10 vols. Danbury: Grolier, 2001. Print. 
 
(Medieval 7: 55).  
 
(Medieval  9: 46). 
 
Note: Within the parenthetical citation, include the number of the volume you used, followed by a colon, 
one space and the page number. 
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Book – Series   

Parks, Peggy J. Animal Experimentation. San Diego: ReferencePoint, 2008. Print. Compact Research.  

(Parks 23). 

Book – Article within a Book (also in a series)  
 
Heaney, Seamus. “Above the Brim.” American Poets. Ed. Harold Bloom. Philadelphia: Chelsea House,  
 

2002. 77-93. Print. Modern Critical Views.  
 
(Heaney 88). 
 
Book – Work in an Anthology 
 
Leggett, John. “Elements of Literature: Character.” Elements of Literature. Third Course. Ed. Kyleene  
 

Beers and Lee Odell. Orlando: Holt, 2007. 96-97. Print.   
 
(Leggett 96).  
  
Book – Edition Other than First 
 
Bellenir, Karen, ed. Mental Health Information for Teens: Health Tips about Mental Wellness and Mental  
 

Illness. 2nd ed. Detroit: Omnigraphics, 2006. Print. Teen Health Series.  
 
(Bellenir 33).  
 
Encyclopedia Article – No Author Identified 
 
“League of Nations.” Encyclopedia Americana. 1992 ed. Print. 
 
(“League” 54).  
 
Encyclopedia Article – Specialized Encyclopedia, Author Identified  
 
Longshore, David. “Hurricane Warnings.” Encyclopedia of Hurricanes, Typhoons, and Cyclones. New  
 

York: Facts, 1998. Print.  
 
(Longshore 181). 
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Government Document 
 
National Commission on Terrorist Attacks upon the United States. The 9/11 Commission Report: Final  
 

Report of the National Commission on Terrorist Attacks upon the United States. Washington:  
 
GPO, 2004. Print. 

 
(National Commission 15). 
 
Introduction, Preface, Forward, Afterward 
 
Paterno, Joe. Foreword. Miracle in the Making: The Adam Taliaferro Story. By Scott Brown and Sam  
 

Carchidi. Chicago: Triumph, 2009. Print.  
 

(Paterno ix).  
 
Electronic Sources 
 
Note: Each type of source listed below includes directions, which give the order of the information in the 
citation, followed by a specific example. However, your teacher may adapt these directions for specific 
courses or assignments. If your teacher requires a website address, it should be included after the date you 
accessed the site. 
 
Article in Online Database 
 
Author/editor’s last name, Author/editor’s first name. “Title of the Article.” Title of the Publication  Day  
 

month and year of print publication if available: page number(s) of the article if available or  
 
n.pag. if page number(s) are not available. Title of Database. Web. Day month and year that you  
 
accessed the database. 

 
Begley, Sharon Lucille. “A Dose of Laughter: Your Guide to Better Health.” Newsweek  4 Oct. 1993: 74- 
 

76. MasterFILE Premier. Web. 21 Dec. 2006. 
 
(Begley). 
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Article in Online Database – Same Title  
 
“Arthur Miller.” Contemporary Authors Online 2000. Gale Group. Web. 15 Mar. 2003. 
 
“Arthur Miller.” Critical Companion to Eugene O'Neill: A Literary Reference to His Life and Work,  

 
Critical Companion 2009. Bloom's Literature. Web. 18 Sept. 2015 

 
(“Arthur Miller,” Contemporary).  
 
(“Arthur Miller,” Critical).  
 
Internet – One Author  
 
Author/editor’s last name, Author/editor’s first name. “Title of the Article or Document if  Given.” Title  
 

of the Website. Name of organization affiliated with the site or N.p. if no organization is  
 
available, Day month and year the internet site was last updated or n.d. if no date is available.  
 
Web. Day month and year you found the site.  

 
Ross, Don. “Game Theory.” Stanford Department of Philosophy. Stanford University, 13 Sept. 2002.  
 

Web. 17 Oct. 2002.   
 
(Ross). 
 
Jones, Andrew.  Protecting Our Children. N.p., n.d. Web. 17 Oct. 2004. 
  
Internet – No Author  
 
“Title of the Article or Document if Given.” Title of the Website. Name of organization affiliated with the  
 

site or N.p. if no organization is available, Day month and year the internet site was last updated  
 
or n.d. if no date is available. Web. Day month and year that you found the site.  

 
“Summary of 2013-2014 Activities.” American Council of Learned Societies. American Council of  
 

Learned Societies, 2015. Web. 30 Sept. 2015. 
 

(“Summary”). 
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E-Books 
 
Note: If a work you use is published in more than one medium (e.g., a book that is also published on the 
Web), follow the format for the medium of the component you primarily consulted. In the place for the 
medium of publication, specify alphabetically all the media you consulted.  
 
Lazo, Caroline Evensen. F. Scott Fitzgerald: Voice of the Jazz Age. Minneapolis, Lerner: 2003. Print,  
 

web.  
 
(Lazo). 
 
E-Books in Online Database 
 
Hook, Andrew. F. Scott Fitzgerald : A Literary Life. New York: Palgrave Macmillan, 2002. eBook  
 

Collection. Web. 23 Oct. 2012. 
 
(Hook). 
 
Personal Interview  
 
Poussaint, Alvin F. Personal interview. 22 July 2007. 
 
(Poussaint 1993). 
 


